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Introduction
Thank you for downloading this document; we hope this gives you some insight into the world of printing 
with Epson

You no doubt own an Epson Photo or Prographics printer and are looking for the best way to reproduce 
your work on the world’s best inkjet printers

The following document has been produced for owners of Epson printers to be able to gain an entry 
level understanding of the colour managed workflow. Professional operators have been using this 
technique for years

This document will guide you through the basic steps required for using the Epson printer driver 
correctly, covering a number of Epson printers

There is an incredible amount of information available these days on colour management that can be 
researched if you wish to further your knowledge 

This version and subsequent releases will be Mac OS X 10.8.x and above, Windows 8 and above. There 
are  similarities with the new operating systems and the old versions, that will not make this document 
hard to follow if you have not updated your operating system

Thank you again for using Epson printers and we hope you enjoy your time printing

The Epson Australia Technical Team
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Colour Management
As mentioned in the introduction, there is a lot of information available these days on colour 
management.  There is also a lot of misinformation, therefore research and guidance is the best 
way to wade through all of the data

The most important thing to remember is, if you are happy with the results your Epson printer 
is producing then you are doing the right thing and there is no need to change anything

If you are not happy with the results you are achieving then there may be some simple steps 
you are missing and this guide aims to help

Colour management is a complex subject that can take years to understand fully. This guide is 
not designed to answer all the questions, but rather provide a starting point of understanding

Colour managed printing is defined and executed well, only if a strict workflow is adhered too. 
If there is any deviation from the workflow then the results are unpredictable, therefore the 
workflow has some hard and fast rules
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Resolution
Correct resolution for printing can depend on a number of factors. Firstly do you have a 
Hi-Res file? Can your digital camera produce high enough resolution for printing.? Has the file 
just been email to you for printing? In these cases there may not be enough resolution to 
achieve acceptable results.

The optimum resolution for Epson Photo printers is 360ppi (*Pixel Per Inch). This will yield the 
absolute best result. Remember this is optimum. In some cases, with larger files the processing 
power to reproduce an image of this resolution could significantly slow down your computer.

Epson’s half-toning technology is designed to produce excellent quality at significantly lower 
resolution, in most cases indistinguishable from higher resolution files. Below is a list of 
recommended resolutions that will produce quality results.

360ppi (Optimum, for images with Text or very fine lines i.e. photo of a bridge with cables)  
240ppi  
180ppi  
120ppi  
Below these resolutions, results may become unpredictable.  

*The PPI pixels per inch, of a computer display is related to the size of the display in inches and the total number of pixels in the horizontal and vertical 
directions. This measurement is often referred to as DPI dots per inch, though that measurement more accurately refers to the resolution of a computer 

printer.
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Workflow Steps

1.Monitor Setup

2.Viewing Conditions

3.Epson Printer

4.Epson Genuine Ink

5.Epson Media

6.ICC Profile*
*ICC profiles are supplied by Epson for all Epson Papers on all Epson Photo Printers using Epson Genuine Ink. The ICC profile determines how the ink/paper combination achieves the correct printed result.  

Other quality paper manufacturers produce ICC profiles for their media
Third Party ink producers do not supply ICC profiles for there ink therefore the results are unknown and this guide will not be of use
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Monitor Setup
The most frequently asked question is “Why don’t my prints match what I see on screen?”

This is not the fault of the printer, as the printer can only do what it is told. If you adjust your 
image to suit your monitor and your monitor is displaying the incorrect colour then the 
printer can only reproduce the data that is sent to it

The most important step in the colour management workflow is the first one:  a calibrated and 
profiled monitor. Consider your monitor as your window to the colour world, if the window is 
dirty or obscured then the results from the printer will be dirty or obscured

Now, most importantly your monitor cannot be correctly adjusted by eye.  A correct result 
can only be achieved by using hardware calibration.  There are a number of excellent affordable 
devices available on the market, some better than others, usually defined by price. Having said 
that any device is better than no device

If a calibration device is not available for any reason, there are also a number of Epson 
Professional Graphics Dealers that can calibrate your monitor. Please check the Epson website 
for a list of Pro Dealers. You do not have to be a Pro User to utilise their services

Prographics Dealers
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Monitor Setup
Now that your monitor is calibrated and profiled correctly there is significantly more chance 
to produce the best results

The monitor should be checked at least every two to four weeks ensuring that viewing 
consistency is at an optimum. This again is a very important step

The type of monitor is also a question in point. It’s unreasonable to expect a 10 year old CRT 
(Cathode Ray Tube) monitor to be able to produce correct results even when a hardware 
profiling device is used. This type of monitor would just be too old and have deteriorated too 
much for any usable quality

Most modern LCD (Liquid Crystal Display) monitors have a much better chance of displaying 
correct results, as with anything, quality is dictated by price and manufacturer
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Viewing Conditions
The next step in the path to a colour managed workflow is the viewing conditions and this is 
probably the hardest aspect to control

In reality it is impossible to control our viewing conditions. The moment any light-source or 
environment changes, even in the slightest, the viewing conditions are changed, therefore you 
must have a realistic expectation of what your images will look like in your viewing 
environment

There are viewing light boxes available that have controlled lighting although this is not always a 
practical solution for viewing images in the real world

The colour event is dependent on three things: the Observer  
the light-source, the object. If one of these changes the  
whole colour event changes, therefore you can see that 
certain expectations need to be catered for
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The Epson Printer
Epson have worked very hard over the years to produce devices that cater for the needs of  
Professionals, Enthusiasts and Amateurs alike. By listening to the needs of the rapidly expanding number 
of digital consumers, we research and develop the best possible solutions that produce the best results

Epson printers cover a large range of these requirements and we here at Epson Australia feel that our 
product has the ability to exceed the expectations that our users demand

There is minimal effort required for the user to set the printer up and obtain results straight away. 
Getting the best result just needs some forethought and adherence to the workflow laid out in this 
document

This RGB Printing Guide is for the current range of Epson Photo printer as of June 2015, in conjunction 
with Adobe’s Photoshop CC, Adobe Lightroom CC, Epson Print Layout and Affinity Photo for Windows 8 
and above and Macintosh OS X 10.8.x and above

Windows 7 and XP users should also be able to use this guide as there are similarities in the print 
drivers.

The guide is also only relevant with printers using Epson Genuine Ink, Epson Genuine Media and supplied 
or custom Epson ICC profiles
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The Epson Printer
When installing the Epson printer, be sure to read all the relevant material and follow any 
installation instructions

When installing the drivers from the supplied disc the required ICC profiles for your Epson 
Photo Printer will install automatically on both the Windows OS and Mac OS. If for any reason 
the ICC profiles do not install, they are available on the Epson Australia website Support 
section. Visit www.epson.com.au

As you progress through this guide the understanding for what the ICC profile does and how 
you use it will become clear.  We suggest you read this guide first then follow along with the 
instructions when you are ready to print
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Epson Genuine Ink
Epson Genuine Ink has been formulated to produce not only the best result from your printer, 
it also protects your investment. Epson ink is the only ink designed to work correctly with the 
Epson print head technology and the very fine filtering and components that are needed to 
produce the best possible prints. The ink also sustains the life of the printer and feeds the print 
head the correct amount needed to accurately produce the right amount of prints per 
cartridge

When using substitute inks not only is there an exponential risk of damage to the printer’s 
mechanical technology and operation, but the amount of prints can also diminish due to 
excessive wear caused by the substandard quality of cheap manufacturing techniques to 
produce cheap inks. The other factor is, most, if not all substitute ink manufacturers do not 
support their product and in most cases do not supply ICC profiles which are a major 
requirement of any workflow and will not quote susceptibility to contaminants or fading

Much of the Epson range of ink and media has been developed to resist contaminants and 
fading. There is an exceptional source of information on print permanence at  
www.wilhelm-research.com
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Epson Media
Epson media works in conjunction with Epson Genuine Ink and Epson ICC profiles to deliver 
the optimum results

There is a large range of media available from Epson to suit everyone’s needs. Certain printers 
in the Epson range have the ability to not only print on photo quality paper, but also fine art 
papers, canvas, matte media, adhesives, transfer paper and more

With the exception of a few media, Epson supplies ICC profiles to accommodate the way 
colour is represented on the media, producing amazing results. Epson media is also specifically 
developed to function correctly with the paper handling of the designated printer, to ensure no 
damage to any moving parts and correct feed through the device
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Epson ICC Profiles
In colour management, an ICC profile is a set of data that characterises a colour input or output 
device, or a colour space, according to standards as formulated by the International Colour 
Consortium (ICC).

Profiles describe the colour attributes of a particular device or viewing requirement by defining a 
mapping between the device source or target colour space and a profile connection space 
(PCS). This PCS is either CIELAB (L*a*b*) or CIEXYZ Mappings may be specified using tables, 
to which interpolation is applied, or through a series of parameters for transformations.

Epson’s printer drivers are ICC compliant so that the optimum result is achievable. Using Adobe 
Photoshop, Lightroom, Elements, Affinity Photo, Epson Print Layout or other ICC compatible 
applications, along with a correctly profiled monitor and Epson’s printer technology you can 
achieve top quality prints

This guide will show how to select the profiles to attach them to the file for printing and also use 
them for displaying a representation of how the final printed image will look using the soft 
proofing facility in Photoshop, Lightroom, Affinity Photo and others.

The soft proofing function is the main reason that a correctly profiled monitor is required.
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Photoshop Setup
• Setting up Photoshop correctly is the 

first step in the workflow

• Go to Edit>Color Settings

• Select either Adobe RGB or sRGB for 
the RGB working space*

• Do not select the monitor profile in 
the RGB space as that is incorrect

*The only setting of concern is the RGB Work Space. Epson printers produce the best results
through the Epson Driver when RGB data is used. If CMYK data is required then a postscript
RIP would produce better results. This Guide is based on the Epson Driver and RGB data only
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Soft Proofing
• One of the main reasons for having the monitor display the correct colour is 

Soft Proofing

• This is the ability to use the media ICC profile as a virtual overlay on the 
image and simulate the result from the printer

• Without calibrating and profiling the monitor this procedure is void

• Soft proofing will, in the grand scheme save money on ink and paper due to 
the fact that your final image will be represented on screen

• Although the representation on screen will be very good, there needs to be a 
certain amount of subjectivity, allowing for things like ambient light to play a 
part in the representation

• Again monitor profiling and soft proofing is the best control for your images 
prior to printing
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Soft Proofing

• Soft Proofing is 
accessed via the 
View>Proof Setup 
menu

• Select Custom

• This is the same on all 
platforms
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Soft Proofing

• Select the correct media 
profile

• Select the required 
Rendering Intent

• Select the Preview and turn 
on and off to see what effect 
the profile has in the image in 
Photoshop

Preview OFF Preview ON
Subtle differences may be seen in the Hue or Saturation of the image.

This will be much more noticeable when soft proofing using a matte media as they have a smaller colour gamut
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Soft Proofing

• Once the Soft Proofing is checked the image may need some minor adjustments to suit your 
requirements

• The only thing to keep in mind is, if the colours are slightly muted due to the media type you 
are printing on, adding saturation to the image to boost the colour will not work

• The media has a defined colour gamut therefore over saturating the image will only produce 
unacceptable results

• If more saturation of colour is required, then trying a different media with a glossier surface 
allowing a wider colour gamut will work

• Custom profiles can also expand the colour gamut slightly but remember different media have 
defined limits of achievable colours
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Printing
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Adobe Photoshop CC
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Prographics Printers 
Mac OS X
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Select Photoshop Manages Color

• Selecting Photoshop 
Manages Colours allows 
access to the paper 
profiles

• Select the correct 
profile that matches the 
printer and paper being 
used

• Select the required 
Rendering Intent* and 
keep Black Point 
Compensation checked

• Select Print Settings
Media Profile selection

*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later
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Printing 
Mac OS X

• Select the Print Setting
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Printing 
Mac OS X

• Select the Media Type to match what 
is in the printer

• Color and Color Setting are selected 
automatically

• Print

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver
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Select Photoshop Manages Color

• Selecting Photoshop 
Manages Colors allows 
access to the paper 
profiles

• Select the correct 
profile that matches the 
printer and paper being 
used

• Select the required 
Rendering Intent* and 
keep Black Point 
Compensation checked

• Select Print Settings Media Profile selection

*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later
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Printing 
Mac OS X

• Select the Select 
Media Type

• Select Print Quality
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IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 31

Printing 
Mac OS X 10.5

Printing 
Mac OS X 10.5Printing 

Mac OS X

IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 30



Printing 
Mac OS X
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 Select the appropriate print 
quality settings.

Select Color Settings to Off

Select Print

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver
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Select the appropriate print quality 
settings.

Printing 
Mac OS X



Printing 
Mac OS X
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Select Color Management



39

Select Off

Select Print

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver

Printing 
Mac OS X



Prographics Printers 
 Windows
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Select Photoshop Manages Color

• Selecting Photoshop 
Manages Colors allows 
access to the paper 
profiles

• Select the correct 
profile that matches the 
printer and paper being 
used

• Select the required 
Rendering Intent* and 
keep Black Point 
Compensation checked

• Select Print Settings Media Profile selection

*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later
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Printing 
Windows

• Select the Media 
Type

• Check Off (No 
Color Adjustment)

• Select OK
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Adobe Photoshop CC 
Windows

• Select Print
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Printing 
Windows

• Select Print

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver
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Consumer Printers 
Windows
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Select Photoshop Manages Color

• Selecting Photoshop 
Manages Colors allows 
access to the paper 
profiles

• Select the correct 
profile that matches the 
printer and paper being 
used

• Select the required 
Rendering Intent* and 
keep Black Point 
Compensation checked

• Select Print Settings Media Profile selection

*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later
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• Select the Preferences 
button

47

Printing 
Windows



Printing 
Windows

xxxx xxxx

IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 44

IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 46
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Printing 
Windows

IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 48

IF YOUR PROPERTIES BOX LOOKS LIKE THIS 
CLICK HERE OR GO TO PAGE 50
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xxxx

Click Advanced
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Printing 
Windows

xxxx

1. Select the Media Type

2. Select ICM

3. Select OFF

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver
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4. Select OK

6. Then Select OK in the next screen

6. Print



Printing 
Windows

xxxx

Click Advanced
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Printing 
Windows

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver

Select the appropriate print quality 
settings.

Select ICM

Select OFF
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Select OK

Select Print in the next panel 



Printing 
Windows

xxxx

Click Advanced
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Printing 
Windows

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver

Select the appropriate print quality 
settings.

Select No Color Adjustment

Select OK

Then Select OK in the next screen

Select Print
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Printing 
Windows

xxxx

Click Advanced
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Printing 
Windows

*By selecting Off (No Color Adjustment) the profile describes the colour to the driver
When not using a profile, colour has no meaning to the driver

Select the Media Type

Select ICM

Select OFF

Select OK

Select Print in the next panel 
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Adobe Lightroom CC
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Adobe Lightroom CC

• Adobe Lightroom CC is another excellent 
software package for image management and 
editing

• Being a colour managed enabled package, makes it 
another alternative to Photoshop for printing to 
Epson Printers using a colour managed workflow

• As mentioned throughout this document, following 
a workflow is the best way to be predictable with 
your colour output
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Adobe Lightroom CC
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Adobe Lightroom CC

• Once the printer is selected the printer profiles 
need to be chosen
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Select required printer profiles

Choose “Other” from 
the Profile Menu



Adobe Lightroom CC
• The selected profiles are now available, 

choose the required profile
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Adobe Lightroom CC

• Select Profile and Rendering 
Intent

• Print
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*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later



Adobe Lightroom CC
Mac OS X

• Select Correct Media 
Type

• Print
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*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later



• Select 
Preferences
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*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later

Adobe Lightroom CC
Mac OS X



• Select 
Correct 
Media Type

• Off (No 
Color 
Adjustment

• Select OK
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*The easiest way to choose a rendering intent is, (bright colourful pictures) select Perceptual.
For subtle muted tones choose Relative colorimetric.

Checking results with soft proofing will be discussed later

Adobe Lightroom CC
Windows



Epson Print Layout
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Epson Print Layout

• Epson have released a new print software 
package Epson Print Layout

• This is available to download from the 
Epson Australia Website
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Epson Print Layout

• This package is easy to use and integrates 
with Nikon NX-i software to offer a 
complete image and printing workflow

• It is a standalone application that makes 
printing to an Epson printer quick and easy
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Epson Print Layout

• Currently there is limited printer support

• The models supported are: P-800, P-600, 
R3000, R2000

• Although older printers are able too be 
operated when using Mac OS X they are 
currently not officially supported

• The Windows version of this software only, 
currently supports the printers listed above
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Epson Print Layout

• Select File>Open

• This imports all the images you require into 
the File Browser
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Epson Print Layout

• Select the required 
Image to print

• This will fill the 
Image Preview 
Screen 
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Epson Print Layout

• Templets can also be created in Layout 
Settings for printing multiple images with 
custom colour backgrounds
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Epson Print Layout

• The Epson Print Layout can be setup for 
Gallery Wraps 
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Epson Print Layout

• Gallery Wrap Styles
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Mirror Image Colour Wrap Image Mirror Image
(Soft Focus)

Wrap Image
(Soft Focus)



Epson Print Layout
• When Printing from Epson Print 

Layout go to Color Settings 
 

• Select Use ICC Profile

• Select the required Profile to 
match the media and Epson 
Printer

• Select the Rendering Intent
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Epson Print Layout

• Once the layout is correct and the colour 
management is setup

• Select Print
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Affinity Photo
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Affinity Photo

• Over the last 12 months Affinity Photo has been made available 
for OSX on the Mac App Store

• This is an excellent photo editing suite that has no subscription 
service, it’s a one off purchase

• Currently this is only Mac based, although a Windows version  
is slated

• Affinity Photo is one of the best image editing application 
available

• Printing with Affinity Photo is as easy as any other package
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Affinity Photo
• Open your image
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Affinity Photo
• Select File - Print
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Affinity Photo
• Once the print 

dialog box it open 
select Affinity 
Photo drop down 
menu
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Affinity Photo
• Choose the Color 

Matching option

• Check that the 
ColorSync radio 
button is selected

• Select the ICC Profile 
that matches the 
media being used
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Affinity Photo
• Choose the Print 

Settings

• Select the 
required Media

• Print Mode 
AccuPhoto HD or 
depending on 
driver version 
Color is greyed 
out
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Affinity Photo
• Press Print
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Epson Advanced Black 
and White Printing
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Advanced B&W

• A selection of Epson printers have the 
ability to use the Advanced Black and White 
feature built into the driver

• The printers that are capable of ABW are:  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SP-2400  
SP-2880  
R-3000  
P-600  
P-800

SP-3800  
SP-3880  
SP-4880  
SP-4900  
SP-7900  
SP-9900



Converting for B&W

• There are a number of ways to convert 
images to B&W

• Please choose your preferred method
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Adobe Photoshop
• B&W 

Conversion

• Adjustments
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Adobe Lightroom

• B&W Conversion

• Adjustments
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Affinity Photo

• Select Black & White in the Adjustment Tab
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• Adjust the Tone controls 
to suit

Affinity Photo
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• Adjust the Tone controls 
to suit

• Select  Merge

Affinity Photo
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NIK Silver Efex
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Advanced B&W

• When setting up B&W images for print 
using Advance B&W feature make sure that 
the print dialogue is set up correctly 
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Advanced B&W

• Photoshop CC 

• Printer Manages 
Colors
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Advanced B&W

• Lightroom CC 

• Managed by 
Printer
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Advanced B&W

• Epson Print 
Layout 

• Type: Advanced 
B&W Photo

• Print
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• Affinity Photo

• Select Color Matching

• Epson Color Controls

Advanced B&W
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• Affinity Photo

• Select Advanced B&W 
Photo

• Print

Advanced B&W
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Advanced B&W Toning
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Advanced B&W Toning

• The Advanced B&W feature also has the 
ability to tone images

• This is available in the Advanced feature of 
the driver
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Advanced B&W Toning
Windows
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Advanced B&W Photo



Advanced B&WToning
Mac OSX
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Advanced B&W Toning

• The new Epson Print Layout Software has 
an additional feature

• The ability to preview any custom changes 
made your images in the preview window

• This is the only software that can do this at 
the time of writing this document
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Advanced B&W

106

Image ToningLive Preview



Conclusion
We hope this guide has helped you to understand the 
requirements for printing to Epson printers. As mentioned in 
the guide earlier, there is a wealth of information available on 
the internet as well as many good publications.

As updates to Operating Systems and Applications are made 
available we will also update this guide.

Please regularly check the Epson Australia Website for updates 
to Drivers, Firmware and Software to get the best from Epson 
products
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Thank You
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Epson Applications and Training Specialist


